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Overview 

This document describes the installation and configuration of CloudShell in a High 

Availability (HA) environment. 

This document should be read in conjunction with the CloudShell High Availability 

Deployment Guide. 

A failover cluster is a group of independent servers (nodes) that work together to 

increase the availability and scalability of clustered nodes. The clustered nodes are 

connected by physical cables and by software. If a disaster occurs and the active 

cluster node goes down, the clustering solution changes the active node automatically 

to the standby server and Quali server starts on the new active node.  

Requirements and Prerequisites 

This section describes the CloudShell clustering requirements. 

The following table lists the requirements for the following infrastructure components: 

NICs, Switches and host. 

Based on the CloudShell High Availability Deployment Guide, the administrator should 

select the optimal set up for the environment (4/6/8 nodes on physical or virtual 

machines). 

4 machines High availability setup 

Component Requirements 

Quali Application 

Server , License 

server, CloudShell 

Portal 

 2 machines running Windows 2012 Server Standard or 
Datacenter edition and above 

 2 network adapters (one for cluster use and one for client use) 
 Failover cluster role installed 
 Windows Failover Cluster Manager installed 
 4 IP addresses free in the client subnet (for Cluster front, and 

components roles) 

SQL cluster 
 According to prerequisites listed in the SQL clustering solution 

6 machines High availability setup 

Component Requirements 

CloudShell HA 

(Quali Application 

Server plus License 

server) 

 2 machines running Windows 2012 Server Standard or 
Datacenter edition and above 

 2 network adapters (one for cluster use and one for client use) 
 Failover cluster role installed 
 Windows Failover Cluster Manager installed 
 3 Available IPs in the client subnet (for Cluster front and 

components roles) 

CloudShell Portal 
 2 machines running Windows 2012 Server Standard or 

Datacenter edition and above 
 2 network adapters (one for cluster use and one for client use) 
 Failover cluster role installed 
 Cluster is configured using Windows Failover Cluster Manager 
 Available IP in the client subnet (for Cluster front) 
 IIS 8.0 installed 
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Component Requirements 

 ASP.NET 4.5 enabled on IIS 8.0 web server (see 
http://www.iis.net/learn/get-started/whats-new-in-iis-8/iis-80-
using-aspnet-35-and-aspnet-45)  

SQL cluster 
 According to prerequisites listed in the SQL clustering solution 

8 machines High availability setup 

Component Requirements 

CloudShell HA 

(Quali Application 

Server plus License 

server) 

 2 machines running Windows 2012 Server Standard or 
Datacenter edition and above 

 2 network adapters (one for cluster use and one for client use) 
 Failover cluster role installed 
 Windows Failover Cluster Manager installed 
 3 Available IPs in the client subnet (for Cluster front and 

components roles) 

CloudShell Portal 

(2 Portal servers plus 

2 Load Balancing 

Servers) 

2 machines with CloudShell Portal (see 6 machines setup) 

2 machines with: 

 Windows 2012 Server Standard or Datacenter edition and 
above 

 2 network adapters (one for cluster use and one for client use) 
 Network load balancing installed (see Installing Windows 

Network Load Balancing) 
 IIS 8 and above installed 
 ASP.NET 4.5 enabled on IIS 8.0 
 Server farm installed (for installation procedures, see 

Configuring the Server Farm) 

SQL cluster 
 According to prerequisites listed in the SQL clustering solution 

Software licenses 

 Windows server 2012 

 SQL server 2012 Enterprise or SQL server 2014 Enterprise 

 CloudShell HA license  

Supported versions of MS SQL Server 

 SQL Server 2012 Enterprise 

 SQL Server 2014 Enterprise 

If deploying on Virtual environment with VMware vCenter 5.5 or above, with HA 

clustering configured across two different ESXi hosts, for more information, see 

https://pubs.vmware.com/vsphere-55/index.jsp#com.vmware.vsphere.avail.doc/GUID-

E90B8A4A-BAE1-4094-8D92-8C5570FE5D8C.html.  

http://www.iis.net/learn/get-started/whats-new-in-iis-8/iis-80-using-aspnet-35-and-aspnet-45
http://www.iis.net/learn/get-started/whats-new-in-iis-8/iis-80-using-aspnet-35-and-aspnet-45
https://pubs.vmware.com/vsphere-55/index.jsp#com.vmware.vsphere.avail.doc/GUID-E90B8A4A-BAE1-4094-8D92-8C5570FE5D8C.html
https://pubs.vmware.com/vsphere-55/index.jsp#com.vmware.vsphere.avail.doc/GUID-E90B8A4A-BAE1-4094-8D92-8C5570FE5D8C.html
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Installation procedure 

This section describes the installation and configuration procedure. Perform the steps in 

the following table: 

Download and install the CloudShell 6.3 

EA High Availability Solution Pack 

Downloading the CloudShell 6.3 EA High 

Availability Solution Pack 

Database configuration Configuring the Database Server cluster 

Quali server installation Installing Quali server 

Quali server configuration Configuring Quali server 

Configure the AlwaysOn availability Group 

(for MSSQL AlwaysOn users) 

AlwaysOn Availability Groups (SQL Server) 

Portal Installation and configuration (not 

for advanced setup users) 

Installing and configuring CloudShell Portal 

Install and configure ARR and load 

balancing 

Configuring the ARR component 

Configure SSL Configuring the CloudShell Portal to support 

SSL 

Downloading the CloudShell 6.3 EA High Availability 

Solution Pack 

The CloudShell 6.3 EA High Availability Solution Pack is available from the Solution 

Packs Download Center. 

Each folder contains an .md5 file with a list of files in that folder and their md5 

checksum. 

Note: Registration to the QualiSystems portal is required, so if you have not already 

done so, register in advance. 

Download the CloudShell 6.3 EA High Availability Solution Pack (zip file) and extract all 

the files under one folder, for example: C:\Quali. Ensure files are placed on the 

exact path on each of the cluster nodes. 

The CloudShell 6.3 EA High Availability Solution Pack (zip file) contains the following 

files: 

 Quali Server folder: files required to cluster Quali server plus elastic search 

 CloudShell Portal folder: files required to cluster CloudShell portal using 

Windows cluster (basic setup) 

 LicenseServer folder: LicenseServer.vbs script that is used in a Windows cluster 

and is triggered by cluster events 

https://support.qualisystems.com/entries/87063688-Solution-Pack-Download-Center
https://support.qualisystems.com/entries/87063688-Solution-Pack-Download-Center
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 Documentation folder: the 6.3 CloudShell High Availability Deployment Guide 

and the 6.3 CloudShell High Availability Installation and Configuration Guide 

 The HASqlPortal.sql file 

Install and configure the License Server 

The License server component is co-hosted with the application server. A Windows 

script monitors the license server service. 

Use the procedures in this section to install and configure the License Server and apply 

the license. 

License Server installation 

To install the License Server: 

1. Follow the License Server installation procedure in the CloudShell Suite 

Installation Guide. 

Configuring each node with License Server 

To configure each node in the system: 

1. Install License Server on each node. 

2. Configure the License Server. 

Note: Use the CloudShell Suite Installation Guide for more information about 

License Server Installation. 

3. Apply the license. 

Create a Configuration Role for WSFC 

To create a configuration role: 

1. Open Windows Failover Cluster Manager. 

 

2. Right-click Roles and select Configure Role…. 

3. Click Next, select the Generic Service option, then click Next. 

4. Enter the path to the LicenseServer.vbs file  

(for example: c:\Quali\LicenseServer.vbs) 

5. Enter a name for the role and click Next. 
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6. Click Next to complete the wizard 

This creates a new role that starts to run cluster events. 

 

Configuring CloudShell components to the License Server Role 

address 

Use the procedures described in this section to configure CloudShell components after 

completing the High Availability configuration. 

All CloudShell components can be configured to the clustered License Server Role 

address. 

To configure CloudShell components to the License Server Role address: 

1. Open the Windows Failover Cluster Manager. 

2. Click the required License Server role. 

The IP Address of the Role displays in the bottom half of the screen. 

 

Note: The CloudShell HA License Server solution requires a dual set of licenses – a 

license for each of the nodes. 

Alternative license server solution 

An alternative license server solution is to host the license server on a separate 

machine (VM). Use either MS Clustering or VM Fault Tolerance solution to handle 

failover. 
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Configuring the database server cluster 

The SQL server database clustering uses the AlwaysOn Availability Group solution. 

AlwaysOn Availability Groups (SQL Server) 

The AlwaysOn Availability Groups feature is a high-availability and disaster-recovery 

solution that provides an enterprise-level alternative to database mirroring. AlwaysOn 

Availability Groups maximizes the availability of a set of user databases for an 

enterprise. An availability group supports a failover environment for a discrete set of 

user databases, known as availability databases that fail over together. An availability 

group supports a set of read-write primary databases and one to four sets of 

corresponding secondary databases. Optionally, secondary databases can be made 

available for read-only access and/or some backup operations. 

An availability group fails over at the level of an availability replica. Failovers are not 

caused by database issues, such as, a database becoming suspect due to a loss of a 

data file, deletion of a database, or corruption of a transaction log. For more information 

about AlwaysOn Availability Groups, see https://msdn.microsoft.com/en-

us/library/hh510230(v=sql.110).aspx. 

Note: AlwaysOn Availability Groups is a Microsoft feature. 

The supported versions of MS SQL Server are: 

 SQL Server 2012  

 SQL Server 2014 

Setting up and configuring an instance of SQL Server to Support 

AlwaysOn Availability Groups 

For more information about AlwaysOn Availability Groups, see 

https://msdn.microsoft.com/en-us/library/gg509118(v=sql.110).aspx. 

Prerequisite 

Set-up nodes with Windows Server Failover Clustering (WSFC) 

Configuring SQL Server AlwaysOn availability group 

To configure the SQL Server AlwaysOn availability group: 

1. Open SQL Server on one of the nodes. 

2. Connect to all SQL servers that should be part of the SQL cluster. 

3. Choose View > Registered Servers. 

https://msdn.microsoft.com/en-us/library/hh510230(v=sql.110).aspx
https://msdn.microsoft.com/en-us/library/hh510230(v=sql.110).aspx
https://msdn.microsoft.com/en-us/library/gg509118(v=sql.110).aspx
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4. Add the required servers to a new group. 

 

5. Right-click on a server and click SQL Server Configuration Manager…. 

 

6. Select SQL Server Services. 

 

7. Right-click the SQL Server instance and select Properties. 
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8. Open the AlwaysOn High Availability tab. 

9. Check the Enable AlwaysOn Availability Groups check-box. 

 

Note: If there is no cluster name, make sure to install Windows failover 

cluster and configure a cluster first. 

10. Right-click the SQL Server instance and click Restart. 

 

11. Enable AlwaysOn for each of the DB cluster nodes.  
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12. Repeat steps 5-10 for each SQL server presented in the MSSQL registered 

servers pane. 

 

The cluster is now configured for AlwaysOn. 

Configure the Application Server 

Quali server works with only one active node in Active-Passive mode. You can change 

any node in the cluster to be the active node. However, only one Quali server should be 

up at any time. Elasticsearch (a search engine that achieves fast search responses), is 

synchronized between nodes to ensure that the latest state is available in all nodes. 

After a node recovery, the node starts and elasticsearch launches automatically for 

synchronization with the online node. 

Use the following procedures to configure Quali server to work in a cluster environment. 

Modifying the elasticsearch.yml configuration file  

To modify the elasticsearch.yml configuration file:  

1. Save the extracted elasticsearch.yml file under the name: 

elasticsearch.yml.old. Keep this file as a backup.  

2. Open the elasticsearch.yml file in a text editor.  

3. In the cluster section, modify the value of cluster.name to your cluster name. 

Use a unique name to distinguish between CloudShell environments in your 

network. For example:  
############################## Cluster 

###############################   
# Cluster name identifies your cluster for auto-discovery. If 

you're running multiple clusters on the same network, make sure 

you're using unique names.  
#  
cluster.name: QS-CS-Local10.qualisystems.local  
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Locating the cluster name 

Cluster names display in the Windows Failover Cluster Manager. After creating a 

cluster, open the Windows Failover Cluster Manager.  

To display the cluster name: 

1. Open the Windows Failover Cluster Manager. 

 

In the explorer tree, the cluster name is displayed under Failover Cluster 

Manager. 

Modify the Quali.vbs file  

To modify the Quali.vbs file:  

2. Save the extracted Quali.vbs file to this name: Quali.vbs.old. Keep this 

file as a backup.  

3. Open the Quali.vbs file in a text editor.  

4. Modify the following values:  

a. Eventlog – The values are $true or $false. If the value is $true, all scripts 

write logs to the Windows event log while running - set to $true by 

default. It’s recommended to leave it with the default. 

b. ScriptPath – The folder which in you store all the PowerShell scripts that 

are in the downloaded CloudShell 6.3 EA High Availability Solution Pack 

zip file. For example:  

Const EventLog = "$true"  
Const ScriptPath = "c:\Quali\QualiServer"  
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Installing and configuring Quali server  

Use the following procedures to install and then configure Quali server to work in a 

cluster environment.  

Installing Quali server  

To install Quali Server: 

1. Follow the Quali Server installation procedure in the CloudShell Suite Installation 

Guide. 

Configuring Quali server  

Configure Quali server to communicate with the computer where the database is 

installed. You can either create a new database or use an existing QualiSystem 

database.  

AlwaysOn Users: Set the Quali server to one of the AlwaysOn nodes. This setting 

changes after configuring the AlwaysOn listener. 

To configure Quali server on the first cluster node:  

1. Configure Quali server (note that during configuration, when you specify the 

License server IP or name, ensure that you use the License server role IP that 

you configured earlier, see the Configuring License Server section). 

2. Run the following command at the command prompt: services.mcs  

3. Right-click the Quali server service and select Stop.  

4. When the service has stopped, right-click Quali server service and select 

Properties.  

5. In the Quali server Properties window, in the Startup type menu, select 

Manual.  

6. Using Windows Explorer, navigate to the following directory:  

[CloudShell Server 

Directory]\QualiSystems\CloudShell\Server  

Where [CloudShell Server Directory] is the directory where CloudShell 

Server is installed.  

7. Save the customer.config file to this name: customer.config.old. Keep this file as 

a backup.  

8. Double-click the customer.config file.  

9. In the <appSettings> section, add the following text:  

<add key="FtsReplicasShards" value="1"/>  

10. Using Windows Explorer, navigate to the following directory:  

[CloudShell Server Directory]\QualiSystems\CloudShell\Server\  

QuickSearch\Config  

Where [CloudShell Server Directory] is the directory where CloudShell 

Server is installed.  
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11. Save the elasticsearch.yml file to this name: elasticsearch.yml.old. Keep this file 

as a backup.  

12. Copy the elasticsearch.yml file that was modified in the procedure “Modifying the 

elasticsearch.yml configuration file” to the QuickSearch folder.  

13. Start the Quali server service.  

14. Stop the Quali Server 

Setting up an AlwaysOn availability group (only for AlwaysOn users) 

NOTE: Make sure to perform the steps in the Configuring Quali server section in order 

to work with the Availability group listener step after configuring the AlwaysOn 

availability group. 

To cluster the database: 

1. Ensure that you create a full back up for all clustered CloudShell databases. For 

more information, see (https://msdn.microsoft.com/en-

us/library/ms187510.aspx). 

1. Make sure to open port 5022 on all cluster machines firewalls 

2. Open the SQL server that you created the CloudShell DBs in, expand the 

AlwaysOn High Availability and right-click Availability Groups. 

3. Click on ‘New Availability Group Wizard…’ 

 

4. Specify a group name 

 

5. Choose the databases you would like to include in the availability group 

6. Make sure that status in the Status column of every database is Meets 

prerequisites. If not, click on the database status, follow the error message and 

resolve the issue. 

https://msdn.microsoft.com/en-us/library/ms187510.aspx
https://msdn.microsoft.com/en-us/library/ms187510.aspx
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7. Click Next. 

Under the Replicas tab, click on ‘Add Replicas’ and connect to all of the 

environment SQL nodes using SQL or windows authentication.  

 

8. Check the Automatic Failover checkbox for each of the servers and choose 

Read-intent only for each of the servers under the readable secondary column. 

9. Click the Listener tab, insert the values for DNS name, port (1433 for MSSQL 

default) and choose Network Mode. If you chose DHCP, then select subnet. If 

Static IP is selected, specify an available IP in the subnet. 

10. Click Next. 

 

11. Choose Full. Specify the database backup file location on the server and click 

Next. 

Wait for the validation step to finish.  
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If an error occurs during this process, click on the error, resolve the problem and 

run the validation step again.   

12. When all steps are free of errors, click Next.  

13. Click Finished. The wizard is finalized and the clustering Role dependencies are 

created. 

 

Now, the availability group is set up, and you can see all relevant data for it under the 

availability group name you specified in early step: 

 

Displaying cluster health information 

To see more information about the cluster health: 

1. Right click on the availability group name. 

2. Click on Show Dashboard. 

 

You can also see that a new Role was generated under the Microsoft Clustering 

manager with type ‘other’ 

 



 

 18 

Configuring Quali server to work with the Availability group listener 

To configure Quali server to work with the Availability group listener 

1. Run the Quali Server Configuration again on the first node. 

2. In the databases section, select the Availability Group Listener as the database 

hostname. 

 

3. Stop the Quali Server service. 

To see the AlwaysOn listener properties, right click on the listener and open the 

properties: 
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Configuring the remaining cluster nodes  

To configure the rest of the cluster nodes: 

1. For each node in the cluster, except the first one that is already configured, 

repeat steps 1-13 from the “Configuring Quali server” section.  

Make sure to use the License server role IP and the AlwaysOn SQL listener IP. 

Creating a Configuration Role  

To create a configuration role: 

1. Make sure that Quali Server service is stopped in all Quali Server nodes. 

2. Open Windows Failover Cluster Manager. 

 

3. Right-click Roles. 
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4. Select Configure Role…. 

5. Click Next, select the Generic Script option, then click Next.  

6. Enter the path to the Quali.vbs file (for example: 

c:\Quali\QualiServer\Quali.vbs).  

7. Enter a name for the role and click Next.  

8. Click Next to complete the wizard. 

This creates a new role that starts to run. This role uses the PS1 files to operate Quali 

server and elasticsearch during cluster events.  

  

Activating Quali server setup on all nodes  

Use Windows Cluster manager to move between all nodes.  

To activate Quali server setup in all nodes:  

1. Open Windows Cluster manager.  

2. Right-click Move and select Select Node.  

  

3. Browse to the required node and move the role to it.  

4. Repeat steps 2 and 3 for all the nodes in the cluster.  
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Configuring CloudShell components to the Quali Server 

Role address 

Use the procedures described in this section to configure all other CloudShell 

components after completing the High Availability configuration for the Quali Application 

server. 

All CloudShell components must be configured to the Quali Server Role address. 

To configure CloudShell components to the Quali Server Role address: 

1. Open Windows Failover Cluster Manager. 

 

2. Select the required Quali Server role. 

The role IP Address displays in the bottom half of the screen. 

 

In cases where a database is not present 

To activate AlwaysOn where a database is not present: 

1. Install Quali server. 

2. Run the configuration of the Quali server from one of the nodes and configure 

the database connection to one of the database cluster nodes (in that way the 

Quali database is generated in one of the database cluster nodes). 

 

3. Stop the Quali server service. 

4. Go to the Clustering the database section. 
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Configuring each node 

To configure each node in the system: 

1. Install CloudShell Portal on each node. For more information, see the “Installing 

CloudShell Portal” section in this document. 

2. Configure the CloudShell Portal with IIS.  

Note: Use the CloudShell Suite Installation Guide for more information about License 

Server Installation. 

Installing and configuring CloudShell Portal 

Use the following procedures to install and then configure License Server to work in a 

cluster environment. 

Installing CloudShell Portal 

To install CloudShell Portal: 

1. Follow the CloudShell Portal installation procedure in the CloudShell Suite 

Installation Guide. 

Note: In order to use CloudShell Portal in High Availability environment, make sure to 

configure it with IIS 8 and above (do not use the default IIs Express). For more 

information, see the CloudShell Suite Installation Guide. 

Modify the CloudShellPortal.vbs file 

To modify the CloudShellPortal.vbs file: 

1. Save the extracted CloudShellPortal.vbs file to this name: 

CloudShellPortal.vbs.old. Keep this file as a backup. 

2. Open the CloudShellPortal.vbs file in a text editor. 

3. Modify the following values: 

a. SITE_NAME = "Default Web Site" – use your site name (can be found in the IIS 
manager) 

b. APP_POOL_NAME = "DefaultAppPool" – use your application pool (can be 
found in the IIS manager) 
For example: 
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Creating a Configuration Role@updated to 7.0 

To create a configuration role: 

1. Open Windows Failover Cluster Manager. 

2. Right-click Roles and select Configure Role…. 

 

3. Click Next, select the Generic Script option, then click Next. 

4. Enter the path to the CloudShell Portal.vbs file (for example: 

c:\Quali\Portal.vbs). 

5. Enter a name for the role and click Next. 

6. Click Next to complete the wizard 

This creates a new role that starts to run.  

 

To configure the portal virtual front with Quali Server: 

1. In the Cluster Manager, open the Roles window. 

2. Click on the portal role. At the bottom of the page, locate the IP address of your 

Portal virtual front. For example, when using Windows cluster to cluster the 

CloudShell Portal, the information in the following image is displayed: 
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The virtual IP for the portal in this example is: 192.168.65.69. 

3. Go to %Program 

Files%\QualiSystems\CloudShell\Server\customer.config file, and 

add the following key: 

<add key="PortalAdressLinkForEmails" 

value="http(s)://PublicServerName:ServerPort"/> 

3.4. Connect to the Quali database using Microsoft SQL Server Management 

Studio. (if you are using SQL AlwaysOn – connect to the AlwaysOn Listener). 

4. Copy the SQL statements below and paste them after changing these 

parameters: 

SQL Statement Parameter details 

<<Quali Database>> Choose the Quali Database your system 

uses 

<<CloudShell Portal  Ip or 

Name>> 
Choose the CloudShell Portal Virtual front 

IP or DNS name 

<<CloudShell Portal Port>> Choose the CloudShell Portal Virtual front 

port 

Run the following SQL statement. This SQL statement ensures that Quali server 

is aware of the portal cluster and does not use the portal cluster nodes for 

communication (for example, links that are in emails sent from Quali server 

should redirect you to the CloudShell Portal cluster and not to one of the 

individual nodes). 

USE <<Quali Database>> 

GO 

 

IF (select count(*) from PortalInfo) > 0 

BEGIN 

 

/*Choose your CloudShell Portal Virtual front Ip or name*/ 

DECLARE @ip NVARCHAR(15) = <<CloudShell Portal  Ip or Name>> 

 

/*Choose your CloudShell Portal Virtual front portal port*/ 

DECLARE @port INT = <<CloudShell Portal Port>> 

 

UPDATE [dbo].[PortalInfo] 

   SET [MachineName] = @ip 

      ,[Port] = @port 
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/*If http is in use, change the http to https*/ 

      ,[PortalUri] = 'http://' + @ip + ':' + 

CONVERT(varchar(10),@port) + '/' 

      ,[ModificationDate] = GETDATE() 

WHERE Id = (select max(Id) from [dbo].[PortalInfo]) 

END 

ELSE  

 PRINT 'No registered CloudShell Portal in the system, please 

register the Portal and run this statement again...' 

GO 

 

Note: Restart of the server is not required. 

Configuring CloudShell Portal to support SSL 

Use the procedures in this section in basic (4 machines) and performance (6 machines) 

setups. For 8 machines setup, SSL off-loading should be set. 

For information about setting up TestShell Portal on IIS including HTTPS, see the 

QualiSystems support article at this link: 

https://support.qualisystems.com/entries/61196243-Setting-up-Testshell-Portal-on-IIS-

including-HTTPS-  

Configuring the Web Server Load Balancing 

This step is only needed for the advanced deployment option. For more information, see 

Deployment Options. For the Basic and Performance options, see to the WSFC role 

configuration step. 

CloudShell Portal load balancing solution is based on Microsoft Application Request 

Routing (ARR). 

Software requirements: 

 Windows Server 2012 or Windows Server 2012 R2 

 IIS 8 

Hardware requirements: 

The HA solution may be deployed on physical servers or virtual servers. 

Microsoft Application Request Routing 

Microsoft Application Request Routing (ARR) for IIS 7.0 and above is a proxy-based 

routing module that forwards HTTP requests to content servers based on HTTP 

https://support.qualisystems.com/entries/61196243-Setting-up-Testshell-Portal-on-IIS-including-HTTPS-
https://support.qualisystems.com/entries/61196243-Setting-up-Testshell-Portal-on-IIS-including-HTTPS-


 

 26 

headers, server variables, and load balance algorithms. A typical ARR deployment is 

depicted in the diagram below: 

 

ARR does not provide fault tolerant deployment features for itself and must rely on other 

complementary technologies and solutions to achieve high availability for the ARR tier. 

 

For more information about Application Request Routing, see 

http://www.iis.net/learn/extensions/configuring-application-request-routing-

(arr)/achieving-high-availability-and-scalability-arr-and-nlb. 

Installing and configuring Network Load Balancing 

This section describes how to install and configure the Network Load Balancing (NLB) 

Manager and to use it to create and manage NLB clusters from a single computer as 

well as replicate the cluster configuration to other hosts.  

http://www.iis.net/learn/extensions/configuring-application-request-routing-(arr)/achieving-high-availability-and-scalability-arr-and-nlb
http://www.iis.net/learn/extensions/configuring-application-request-routing-(arr)/achieving-high-availability-and-scalability-arr-and-nlb
http://i2.iis.net/media/7178029/achieving-high-availability-and-scalability---arr-and-nlb-511-ARR Overview.jpg?cdn_id=2015-04-07-001
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Installing Windows Network Load Balancing 

To install Windows Network Load Balancing: 

1. Click Start > Administrative Tools > Server Manager.  

2. Click Manage and then select Add Roles and Features. 

 

3. Click Next. 

4. In the Add Roles and Features Wizard select Installation Type. 

 

5. Choose Role-based or feature-based installation and click Next. 

 

6. Select a server for the installation and click Next. 
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7. In the Select features menu, select Features.  

 

8. In the Features selection pane, select the Network Load Balancing option. 
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9. In the Add features that are required for Network Load Balancing pop-up, click 

Add Features. 

10. In the Features selection pane, click Next. 

 

11. In the Confirm installation selections window select the Restart the destination 

server automatically if required option. 

 

12. Click Install . 

13. Repeat steps 1-13 in each of the ARR servers (this can be done in parallel). 
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Configuring Windows Network Load Balancing 

This section describes how to configure Windows Network Load Balancing using the 

NLB Manager. 

To configure Windows Network Load Balancing: 

1. Click Start > Administrative Tools > Network Load Balancing Manager or 

from the command prompt, type NLBMgr and then press Enter). 

 

2. Right click Network Load Balancing Clusters. 

 
3. Select New Cluster. 
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4. In the Host field, enter the details of the ARR servers and then click Connect. 

5. Choose the clients network and click Next. 

 

Note: Due to a limitation, the network card must use a static IP address and not DHCP. 

(see Known issues and limitations). 

6. In the New Cluster: Connect window, choose the clients subnet and click Next. 
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7. In the New Cluster: Cluster IP Addresses window, click Add…. 

 

8. In the Cluster Parameters section, add the cluster ‘full Internet name’ and click 

Next. This name is used in the DNS as the Virtual front name. 

9. In the ‘Port Rules’ section, click Edit. 

10. Choose the port range to use in the cluster. This is the port range that is 

redirected in the cluster to other hosts. 

a. Usually http users use from: 80 to:80 
b. Usually SSL users use from:443 to:443 
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11. Under Filtering mode, choose Single host and click OK. 

12. Click Finish. 

Adding another host to the Network Load balancing 

cluster 

To add another host to NLB cluster: 

1. Open Network Load Balancing Manager. 

 

2. Right-click the required cluster name. 

3. In the pop-up menu, choose Add Host to Cluster.  

4. In the Add Host to Cluster section, enter the host name details and click 

Connect.  

5. Choose the client network and click Next. 

6. Click Next and then click Finish. 

Working with the ARR cluster Virtual front 

After configuring the ARR load balancing cluster, you can use the cluster IP or name 

(for example, 192.162.63.110 or CloudShellPortal-LB) to browse the portal. 

To configure the portal virtual front with Quali Server: 

1. Connect to the Quali database using Microsoft SQL Server Management Studio. 

(if you are using SQL AlwaysOn – connect to the AlwaysOn Listener). 

2. Copy the SQL statements below and paste them after changing these 

parameters: 

SQL Statement Parameter details 

<<Quali Database>> Choose the Quali Database your system 

uses 

<<CloudShell Portal  Ip or 

Name>> 
Choose the CloudShell Portal Virtual front 

IP or DNS name 

<<CloudShell Portal Port>> Choose the CloudShell Portal Virtual front 

port 

Run the following SQL statement. This SQL statement ensures that Quali server 

is aware of the portal cluster and does not use the portal cluster nodes for 

communication (for example, links that are in emails sent from Quali server 

should redirect you to the CloudShell Portal cluster and not to one of the 

individual nodes). 
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USE <<Quali Database>> 

GO 

 

IF (select count(*) from PortalInfo) > 0 

BEGIN 

 

/*Choose your CloudShell Portal Virtual front Ip or name*/ 

DECLARE @ip NVARCHAR(15) = <<CloudShell Portal  Ip or Name>> 

 

/*Choose your CloudShell Portal Virtual front portal port*/ 

DECLARE @port INT = <<CloudShell Portal Port>> 

 

UPDATE [dbo].[PortalInfo] 

   SET [MachineName] = @ip 

      ,[Port] = @port 

/*If http is in use, change the http to https*/ 

      ,[PortalUri] = 'http://' + @ip + ':' + 

CONVERT(varchar(10),@port) + '/' 

      ,[ModificationDate] = GETDATE() 

WHERE Id = (select max(Id) from [dbo].[PortalInfo]) 

END 

ELSE  

 PRINT 'No registered CloudShell Portal in the system, please 

register the Portal and run this statement again...' 

GO 

 

Note: Restart of the server is not required 

Monitoring the Cluster environment 

To monitor the ARR cluster you can use features of the Network load balancing 

manager: 

 Cluster log in the bottom of the application 

 Right click on specific host and click ‘host status’  

Working with HTTPS Portal 

To work with HTTP with the CloudShell Portal, configure the port range in the cluster to 

include SSL port (443). For more information, see Configuring Windows Network Load 

Balancing. 



 

 35 

Configuring Portal load balancing 

To be able to communicate in a load balancing environment, start by configuring all web 

servers. This section describes how to enable communication between IIS on the load 

balancing server and it should be configured on load balancing servers using Windows 

Server Manager. 

To configure all web servers to communicate in a load balancing environment: 

1. Click Start > Administrative Tools > Server Manager. 

2. Click Manage and then select Add Roles and Features. 

 

3. In the Before You Begin tab, click Next. 

4. In the Installation type tab, choose Role-based or feature-based installation. 

5. In the Server selection tab, select the server.  

6. In the Server Roles tab, select the Web Server (IIS) option. 

7. In the Add Roles and Features Wizard, click Add Features . 

 

8. In the Feature tab click Next. 

9. In the Web Server Role tab click Next. 
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10.  In the Role Services expand the Application Development section and choose 

the Management Tools section. 

 

11. Click Add Feature in the pop-up, then click Next. 

12. Click Install. 

13. Open IIS and under the IIS server configurations choose Management Service. 

 

14. Stop the Management Service. 

15. Select the Enable remote connection option and click Apply. 

16. Start the Management Service. 

Repeat steps 1-16 for each Portal server. 

Adding Servers to the main IIS Manager 

To add all Portal servers to the IIS Manager in the ARR machines: 

1. Click Start > Administrative Tools > IIS Manager. 

2. On the left side of the IIS Manager window, click the Connect icon. 

 

3. Choose Connect to a Server…. 
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4. In the Server name text box, specify the remote web server name. 

 

5. If a server certificate alert is displayed, click Connect. 

 

6. Choose a name for the server. This name is displayed in the Start page tree in 

the left pane of the IIS Manager. 

 

The server name now displays in the Connection pane. 

7. Repeat steps 1-6 for each of the Portal machines. 

Configuring the ARR server 

To Configure the ARR server: 

1. Download and install Microsoft Web Platform Installer 5.0: 

http://www.microsoft.com/web/downloads/platform.aspx 

2. Open the Microsoft web platform installer and search for Application Request 

Routing 3.0. 

http://www.microsoft.com/web/downloads/platform.aspx
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For more information, see 

http://blogs.iis.net/roman/archive/2013/07/26/application-request-router-arr-3-0-

rtm-is-now-available.aspx 

3. Click Add > Install. 

4. Click I accept. 

Configuring the Server Farm 

To configure the server farm: 

1. Open the IIS manager on the ARR server. 

 

2. Under your local server, right-click Server Farm…. 

 

3. Click Create Server Farm. 

 

4. In the Server farm name text field, enter the Server Farm name, and click Next. 

5. Add the Portal machines details and click Finish. 

http://blogs.iis.net/roman/archive/2013/07/26/application-request-router-arr-3-0-rtm-is-now-available.aspx
http://blogs.iis.net/roman/archive/2013/07/26/application-request-router-arr-3-0-rtm-is-now-available.aspx
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6. In the Rewrite Rules window, click Yes.

 

7. To open the Server Farm main menu, click on the server farm name. 

 

8. Open the Server Affinity section. 

9. Select the ‘Client affinity’ option and in the Cookie name text box change the 

name to ‘QualiARRAffinity’ and click Apply. 

 

10. Return to the Server Farm main menu and click the Load Balance section. 
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Verifying that the system is up and working 

To verify that the system is up and working: 

1. Open IIS manager and click Default Web Site in the ARR server. 

2. Under the management Website section in the Action pane click Restart. 

3. Under the Browse Website menu item, click Browse *:80 (http). 

 

A browser opens with the CloudShell login screen (there might be a short delay the first 
time that this is performed). 

 

4. In the Server Farm Main menu, go to Monitoring and Management.  

 
Ensure that all servers have the status of Available and Healthy. 

Alternatives: 

Load balancing the IIS web servers with MS ARR. There are limitations if using that 

solution (see Known issues and limitations). 
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Configuring ARR and IIS to support SSL in an 

HA scenario 

The SSL off-loading approach is used to support SSL in Advanced CloudShell Portal 

setup.  

Before you begin 

Ensure that 

 ARR is installed and configure on at least two machines 

 The ARR machines are configured in a ‘Load balancing’ cluster using ‘Load 

balancing manager’ 

 Load balancing manager is configured to handle traffic from port 443 (SSL) 

 CloudShell Portal machines are configured to be used with http binding 

Configuring ARR to support SSL 

To configure the ARR to support SSL: 

1. Open the IIS Manager on the ARR machine. 

2. Go to the Default Web Site configuration and open the ‘Bindings…’ 

3. In the Add Site Binding window, add a new binding of type http, specify the Host 

name and select the relevant certificate. 

 
4. Click OK, and close the bindings menu. 

5. Open the ‘Default Web Site’ configuration and choose SSL Settings. 

6. Check the Require SSL and choose the Client certification setting. 
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7. Repeat steps 1-6 to all ARR machines. 

Configuring ARR to support SSL offloading 

To configure ARR to support SSL offloading: 

1. On the ARR machine open the IIS manager. 

2. Open the ARR server farm and double-click the ‘Routing Rules’ icon 

 

3. Make sure that the ‘Enable SSL offloading’ option is selected. 

 

4. Repeat steps 1-3 with all the ARR machines. 

Recommendations: 

 Use Centralized SSL Certificate to share the same customer certificate between all ARR 
machines. For more information, see http://www.iis.net/learn/get-started/whats-new-
in-iis-8/iis-80-centralized-ssl-certificate-support-ssl-scalability-and-manageability  

http://www.iis.net/learn/get-started/whats-new-in-iis-8/iis-80-centralized-ssl-certificate-support-ssl-scalability-and-manageability
http://www.iis.net/learn/get-started/whats-new-in-iis-8/iis-80-centralized-ssl-certificate-support-ssl-scalability-and-manageability
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 Use IIS Shared Configuration to share the IIS configuration between the servers. For 
more information, see http://www.iis.net/learn/manage/managing-your-configuration-
settings/shared-configuration_264  

 Use URL rewrite to redirect users from http to https. For more information, see 
http://www.iis.net/downloads/microsoft/url-rewrite  

 Basic ARR configuration information, see 
http://www.iis.net/learn/extensions/configuring-application-request-routing-
(arr)/define-and-configure-an-application-request-routing-server-farm. 

http://www.iis.net/learn/manage/managing-your-configuration-settings/shared-configuration_264
http://www.iis.net/learn/manage/managing-your-configuration-settings/shared-configuration_264
http://www.iis.net/downloads/microsoft/url-rewrite
http://www.iis.net/learn/extensions/configuring-application-request-routing-(arr)/define-and-configure-an-application-request-routing-server-farm
http://www.iis.net/learn/extensions/configuring-application-request-routing-(arr)/define-and-configure-an-application-request-routing-server-farm
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How to create a cluster in Windows failover 

manager 

This section provides general instruction how to configure a cluster with Failover Cluster 

Manager. Creating a cluster is a pre-requisite to most of the CloudShell 6.3 EA High 

Availability Solution Pack setups. 

Installing the failover cluster feature 

This section describes how to use Windows Server Manager to install a failover cluster. 

To install the failover cluster feature: 

1. Click Start > Administrative Tools > Server Manager. 

2. Click Manage and then select Add Roles and Features. 

 

3. Click Next until you reach the Features tab. 

 

4. Click Failover Clustering. 
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5. Click Add Features. 

6. Click Next, install the feature and close the wizard. 



 

 46 

Configuring a new cluster 

To configure a new cluster: 

1) Open the Windows Failover Cluster Manager. 

2) In the main page, click on Validate configuration…. This opens a wizard that 

helps testing the cluster configuration and generates a report. 

3) In the wizard, click Next. 

4) Enter the names of the cluster nodes and click Next. 

 

5) Choose Run all tests and click Next. 

6) Click Next to start the running of the tests. This could take a few minutes. 

After the tests have run, inspect the resultant report and see if there are errors. 

Do not consider errors that relate only to the storage section as the CloudShell 

6.3 EA High Availability Solution Pack does not use shared storage. To help with 

the examination of the results, you can open the html version of the report by 

clicking View report .  
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7) Select the Create the cluster now using the validated nodes check-box and 

click Finish. 

 

The Create cluster wizard opens. 

8) In the first page of the wizard, click Next. 

9) Enter a cluster name. This name is published to the DNS. Click Next. 

10) In the Confirmation page, click Next. 

11) Click Next. The wizard concludes. 

The cluster is now configured. 

Cluster related information can be seen in the cluster tree in the left pane inside Failover 

Cluster Manager. 
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Maintenance of the HA solution 

How to upgrade and manage configuration changes on the cluster. 

Upgrading CloudShell from 6.2.2 or 6.2.3 HA solutions 

This section describes the required steps to upgrade the Quali server clustering 

environment to a new version of CloudShell. 

Repeat the following procedure for each Quali server node in the Quali server clustering 

environment.  

Note: Do not perform this procedure in parallel. Upgrade each node separately. 

To upgrade CloudShell from version 6.2.2 or 6.2.3: 

1. Open Windows Cluster manager. 

2. Right-click the Quali Server Role. 

 

3. Click Stop Role.  

When the role stops, a Java process starts. 

4. In Task Manager, close the java.exe process (do this in all of the nodes in the 

cluster). 

If more than one Java process is running, the java.exe process that is running 

from the Quali server folder must be closed. 

5. Navigate to the following folder: 

Qualisystems\CloudShell\Server\Quicksearch\config 

6. Make a backup copy of the elasticsearch.yml file and move the backup copy to 

another folder as this file is overwritten during the upgrade process. 

7. Download the CloudShell 6.3 EA High Availability Solution Pack from the 

Solution Packs Download Center. 

8. Copy the Quali server files to the same folder where the files from the earlier 

version are saved. Replace old files if needed. When upgrading from 6.2.2 or 

6.2.3 to 6.3, use the Quali.vbs file from version 6.3 plus the Functions.ps1 file 

provided in the CloudShell 6.3 EA High Availability Solution Pack. 

9. Perform the following steps for each node (do not perform this procedure in 

parallel, upgrade each node separately):  

a. Install the new version of CloudShell. 

b. Run the server QsConfig wizard. 

https://support.qualisystems.com/entries/87063688-Solution-Pack-Download-Center
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10. Stop the Quali Server service and then perform the following steps: 

a. Change the Quali server service to Manual. 

b. Copy the backup elasticsearch.yml file to the correct location: 

(Qualisystems\CloudShell\Server\Quicksearch\config) 

11. Start the Quali server service, ensuring that the service starts successfully. 

12. Open Windows Cluster manager. 

13. Right-click the Quali Server node and in the context menu click Start Role to 

start the Cluster Quali Server Role. 

14. Move the role between all nodes – see Moving the role between all nodes. 

Moving a WSFC role between nodes 

To move the role between all nodes: 

1. Open Windows Cluster manager. 

2. Right-click Move and in the context menu, click Select Node. 

 

3. Browse to the required node and move the role to it. 

4. Repeat steps 2 and 3 for all the nodes in the cluster. 
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Upgrading to a new version of CloudShell (with 6.3 HA 

solution pack) 

This section describes the required steps to upgrade the Quali server clustering 

environment to a new version of CloudShell with the 6.3 HA solution pack. 

Repeat the following procedure for each cluster node in the clustered environment. 

Note: Do not perform this procedure in parallel. Upgrade each node separately. 

To upgrade to a new CloudShell version: 

1. Download the new CloudShell version from QualiSystems download center. 

2. Open Windows Cluster manager. 

3. Right-click the Quali Server Role. 

 

4. Click Stop Role.  

When the role stops, a Java process starts. 

5. In Task Manager, close the java.exe process (do this in all of the nodes in the 

cluster). 

If more than one Java process is running, the java.exe process that is running 

from the Quali server folder must be closed. 

6. Navigate to the following folder: 

Qualisystems\CloudShell\Server\Quicksearch\config 

7. Make a backup copy of the elasticsearch.yml file and move the backup copy to 

another folder as this file is overwritten during the upgrade process. 

8. In the Windows cluster, stop the CloudShell Portal role. 

9. In the Windows cluster, stop the CloudShell License server role. 

a. Start the CloudShell installation on the first node. 

a. Install the new version. 

b. Run the License server configuration wizard. 

c. Close all the other configuration wizards. 

d. In Task Manager, make sure that the Quali server service status is 

stopped. 

10. Start the CloudShell installation on the second node. 

a. Install the new version. 

b. Run the License server configuration wizard. 

c. Close all the other configuration wizards. 

d. In Task Manager, make sure Quali server service status is stopped. 

https://support.qualisystems.com/entries/22858046-download-center
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11. Open Windows Cluster manager, right-click the node and then click Start Role 

to start the CloudShell License server Role. 

12. Open the Quali Server configuration Wizard on the first node and configure the 

server. 

13. Stop the Quali Server service. 

a. Change the Quali server service to Manual. 

b. Copy the backup elasticsearch.yml file to the correct location: 

(Qualisystems\CloudShell\Server\Quicksearch\config). 

c. Make sure that the following key exists in the Server customer.config file. 

<add key="FtsReplicasShards" value="1"/> 

d. In Task Manager, make sure Quali server service status is stopped. 

14. Repeat steps 11-12 with the second node. 

15. Open Windows Cluster manager, right-click the node and then click Start Role 

to start the Cluster Quali Server Role. 

16. Move the role between all nodes – see Moving the role between all nodes. 

17. Configure all other CloudShell applications on the first node and then on the 

second node. 

18. Open Windows Cluster manager, right-click the node and then click Start Role 

to start the Cluster CloudShell Portal Role. 
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Known issues and limitations 

 CloudShell application warm upgrade is currently not supported. 

 The CloudShell BI solution is currently not supported in a high availability setup. 

It is possible to use CloudShell BI with any of the CloudShell 6.3 EA High 

Availability Solution Packs. 

 Where the NLB Manager is connected through a DHCP IP address, the network 

card must be connected to a static IP address. 
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Troubleshooting 

Troubleshooting topics are discussed in this section. 

PowerShell Execution Policy 

The Quali High Availability solution uses PowerShell code to manage the cluster. To 

use the solution, ensure that you have Execution Policy on the machine.  

If, after starting the Quali Server Role, the role fails with an ‘incorrect function’ error 

(this error can be found both in the cluster manager and in the Windows event viewer), 

run the following steps: 

To make sure that the execution policy is unrestricted on the machine: 

1. Open PowerShell using administrator credentials. 

2. Run the following command: 

Get-ExecutionPolicy. 

The command should return the result: Unrestricted. 

However, if this result is not received, perform the following procedure: 

1. Open PowerShell using administrator credentials. 

2. Run the following command: 

Set-ExecutionPolicy Unrestricted. 

In the registry, make sure that the following key value is valid: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\PowerShell\1\ShellIds\Microsoft.PowerShel

l 

 

Example 

The following image shows an ‘incorrect function’ error. 
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Appendix 

This appendix contains reference information and a glossary of terms. 

References 

Topic URL 

Application Request Routing 

Version 2 Overview 

http://www.iis.net/learn/extensions/planning-for-

arr/application-request-routing-version-2-overview  

CloudShell distributed execution 

server: 

https://support.qualisystems.com/entries/87064507-

Distributed-Provisioning-DisPro-CloudShell-6-2-

feature- 

Create a New Network Load 

Balancing Cluster 

https://technet.microsoft.com/en-

us/library/cc771008.aspx 

Create a new Network Load 

Balancing Port Rule 

https://technet.microsoft.com/en-

us/library/cc733056.aspx 

Define and Configure an 

Application Request Routing 

Server Farm – step-by-step 

guide 

http://www.iis.net/learn/extensions/configuring-

application-request-routing-(arr)/define-and-

configure-an-application-request-routing-server-

farm  

Health check http://blogs.iis.net/richma/application-request-routing-

health-check-features 

Setting up TestShell Portal on IIS 

including HTTPS 

https://support.qualisystems.com/entries/61196243-

Setting-up-Testshell-Portal-on-IIS-including-HTTPS- 

Virtual environment deployment 

on VMware vCenter 5.5 or 

above, with HA clustering 

configured across two different 

ESXi hosts. 

https://pubs.vmware.com/vsphere-

55/index.jsp#com.vmware.vsphere.avail.doc/GUID-

E90B8A4A-BAE1-4094-8D92-8C5570FE5D8C.html 

Windows load balancing 

manager 

https://technet.microsoft.com/en-

us/library/cc776931%28v=ws.10%29.aspx  

Windows Server Manager Step-

by-Step Guide 

https://technet.microsoft.com/en-

us/library/cc753762(v=ws.10).aspx 

Documentation 

Additional technical documentation is available in the QualiSystems' Download Center. 

Operational documentation for all High Availability applications is available by clicking 

the Help option in any CloudShell application. 

For our discussion forums, you can access the QualiSystems Customer Portal. 

http://www.iis.net/learn/extensions/planning-for-arr/application-request-routing-version-2-overview
http://www.iis.net/learn/extensions/planning-for-arr/application-request-routing-version-2-overview
https://support.qualisystems.com/entries/87064507-Distributed-Provisioning-DisPro-CloudShell-6-2-feature-
https://support.qualisystems.com/entries/87064507-Distributed-Provisioning-DisPro-CloudShell-6-2-feature-
https://support.qualisystems.com/entries/87064507-Distributed-Provisioning-DisPro-CloudShell-6-2-feature-
https://technet.microsoft.com/en-us/library/cc771008.aspx
https://technet.microsoft.com/en-us/library/cc771008.aspx
https://technet.microsoft.com/en-us/library/cc733056.aspx
https://technet.microsoft.com/en-us/library/cc733056.aspx
http://www.iis.net/learn/extensions/configuring-application-request-routing-(arr)/define-and-configure-an-application-request-routing-server-farm
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http://www.iis.net/learn/extensions/configuring-application-request-routing-(arr)/define-and-configure-an-application-request-routing-server-farm
http://blogs.iis.net/richma/application-request-routing-health-check-features
http://blogs.iis.net/richma/application-request-routing-health-check-features
https://support.qualisystems.com/entries/61196243-Setting-up-Testshell-Portal-on-IIS-including-HTTPS-
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https://pubs.vmware.com/vsphere-55/index.jsp#com.vmware.vsphere.avail.doc/GUID-E90B8A4A-BAE1-4094-8D92-8C5570FE5D8C.html
https://technet.microsoft.com/en-us/library/cc776931%28v=ws.10%29.aspx
https://technet.microsoft.com/en-us/library/cc776931%28v=ws.10%29.aspx
https://technet.microsoft.com/en-us/library/cc753762(v=ws.10).aspx
https://technet.microsoft.com/en-us/library/cc753762(v=ws.10).aspx
https://support.qualisystems.com/entries/22858046-download-center
https://support.qualisystems.com/
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Glossary 

Terms used in this guide are described in the following table. 

Term Description 

Active-Active All nodes in the cluster are active. A load balancing algorithm/policy 

determines the preferred node for a given session. This is a more scalable 

architecture. However, it is more complex to manage. 

Active-Passive A fully redundant instance of each node is present. The passive node is 

brought online when its associated primary node fails. 

Active-Standby One node in the cluster is active. The other node is inactive until failover is 

triggered (warm standby). 

AlwaysOn 

Availability 

Groups 

A high-availability and disaster-recovery solution that provides an 

enterprise-level alternative to MSSQL database mirroring. 

ARR Active Request Routing. This is an IIS server native load balancing 

solution. 

ARR Server 

Farm 

A logical group of application servers where HTTP requests are routed 

based on HTTP inspection rules and load balance algorithm. 

Availability 

databases 

A failover environment for a discrete set of user databases (an availability 

group) that fail over together. 

Availability 

replica 

An instantiation of an availability group that is hosted by a specific instance 

of SQL Server and that maintains a local copy of each availability database 

that belongs to the availability group.  

Two types of availability replicas exist: a single primary replica and one to 

four secondary replicas. The server instances that host the availability 

replicas for a given availability group must reside on different nodes of a 

single Windows Server Failover Clustering (WSFC) cluster. 

NLB Network Load Balancing. Use the NLB Manager to create and manage 

NLB clusters from a single computer. 

SAN Storage area network, dedicated network used to enhance storage 

devices. It is a high-speed network, providing a direct connection between 

servers and storage, including shared storage, clusters, and disaster-

recovery devices. 

SPOF Single Point of Failure. 

Warm Upgrade An administrator is able to upgrade one node of the cluster to a new 

version of CloudShell (Quali Server) while the other node is active, then fall 

back to the new node and upgrade the standby without any downtime for 

the end user.  
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Term Description 

Windows load 

balancing 

manager 

Windows load balancing manager enables you to create and manage 

Network Load Balancing (NLB) clusters from a single computer. By 

centralizing NLB administration tasks, many common configuration errors 

are eliminated. 

WSFC Windows Server Failover Clustering 

 


